
 <<YourApp>> Help Index

How To ...
<<add your application-specific "how to" topics here>>

Commands
File menu
Edit menu
Record menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Send... Sends the active document through electronic mail.
Exit Exits <<YourApp>>.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Insert New 
Object

Inserts and embeds an object, such as a chart or an equation in a document.

Links List and edit links to embedded documents.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in <<YourApp>>.    Select the type of new file 
you want to create in the File New dialog box.    << Remove previous sentence if your 
application supports only one document type. >>

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

<< Delete this help topic if your application supports only one document type. >>

Specify the type of document you wish to create:
<< List your application's document types here >>



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
<< List your application's file types here. >>

Drives
Select the drive in which <<YourApp>> stores the file that you want to open. 

Directories
Select the directory in which <<YourApp>> stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    <<YourApp>> 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, <<YourApp>> displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, <<YourApp>> displays the Save As dialog box so 
you can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    <<YourApp>> displays the 
Save As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



Send command (File menu)

Use this command to send the active document through electronic mail.    This command 
presents a mail window with the active document attached to it.    You may then fill out the 
To: field, Subject: field, etc., and add text to the body of the message if you wish.    When you
are finished you may click the "Send" button to send the message.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    <<YourApp>> adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application 
chooses via the OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your <<YourApp>> session.    You can also use the Close 
command on the application Control menu.    <<YourApp>> prompts you to save documents
with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    
Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in <<YourApp>>, such as File Open.    A check mark appears next 
to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in <<YourApp>>,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your 
application offers. >>

Click To

Open a new document.

Open an existing document.    <<YourApp>> displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, <<YourApp>> displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.

Go to the first record in the current selection.

Go to the previous record in the current selection.

Go to the next record in the current selection.

Go to the last record in the current selection.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the <<YourApp>> window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or 
the keyboard arrows to move the splitter bars.    When you are finished, press the mouse 
button or enter to leave the splitter bars in their new location.    Pressing escape keeps the 
splitter bars in their original location.    << In a single document interface application, this 
command will appear on the View menu. >>



1, 2, ... command (Window menu)

<<YourApp>> displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using <<YourApp>> and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
<<YourApp>>.



Context Help command 

Use the Context Help command to obtain help on some portion of <<YourApp>>.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the <<YourApp>> window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>





Introduction

Usenet Newsgroups
Introduction to News Rover



Configuring News Rover

News Rover works by connecting to a Usenet news server, searching through messages in a set of 
newsgroups you select, and saving messages that match criterion you set up.    Before you can run News 
Rover, you must do the following things:

1. Specify basic configuration information such as the address of your news server.

2. Get the list of newsgroups that are available on your news server.

3. Set up one or more "Interest Groups'' that specify what types of messages and files you are 
interested in and which newsgroups are to be searched.

The first time you run News Rover, it will run a "wizard'' to guide you through the basic configuration 
setup.    This wizard will prompt you to enter the address of your news server and allow you to make some
other choices.    Once the news server address has been specified, News Rover will no longer present the
configuration wizard each time you start it.

The configuration wizard only prompts you to enter the basic configuration information needed to get 
News Rover running.    There are a number of other controls that you can set or change later while News 
Rover is running.    To set or change configuration options, start News Rover and click the "Configure'' 
item that is on the main menu.    This will present a Windows property sheet with several tabs that are 
related to various configuration options.    Each of these property pages is described below.

Server configuration page
General configuration page
Connection configuration page
Schedule configuration page
Duplicates configuration page
Split-message files configuration page
Getting the list of newsgroups



Interest Groups

When you use News Rover you're saying, in essence, I want this kindof information, from this set of 
newsgroups, with these criteriafor matching, and I want you to do this with what you extract.

This set of information is called an "Interest Group''.    You can have more than one interest group active at
a time, each scouring some set of newsgroups for messages and files.    For example, you could have 
one interest group which searched through all of the basketball newsgroups looking for messages that 
mention "Chicago Bulls'', a second interest group looking through all of the "for sale'' type newsgroups for 
messages containing the phrase "model airplane'', and a third interest group collecting all messages with 
attached picture files in the "alt.binaries.pictures.celebrities'' newsgroup.

To manage interest groups, click "Interests'' on the main News Rover menu. You will be shown a screen 
listing each interest group that you have defined.    The screen also has a set of buttons.    To perform an 
action on an interest group, click on the name of the interest group and then click one of the buttons.    
You can also double-click an interest group name to modify the characteristics of the interest group.

Creating an Interest Group
Modifying an interest group



Running News Rover

Once you have configured News Rover, gotten the list of available newsgroups, and set up at least one 
interest group, you are ready to run News Rover.    News Rover has two modes of operation: on-demand 
and scheduled.

On-demand execution
Scheduled execution



Reading Messages and Getting Attached Files

As News Rover collects messages and attached files, it saves them in files called "message bases'' 
where they can be read, viewed, stored into external files, deleted, and printed. If the messages have 
attached files they can be displayed or processed while reading their associated messages.

In addition, as News Rover processes JPG picture files it makes thumbnail size copies of them to be 
displayed in the picture gallery for the interest group.

Thus, there are two ways to see attached files which are pictures: View the pictures as part of reading a 
message, or view the contents of the picture gallery.

Reading messages
The Picture Gallery





Usenet Newsgroups

Usenet newsgroups are one of the most popular and fastest growing parts of the Internet.    Currently, 
there are over 30,000 newsgroups, and more are being added every day.    There are newsgroups for 
practically every topic you can imagine (and some that you are better off not imagining).    About a 
gigabyte of messages are distributed through the newsgroups every day.    Because of the volume of 
messages, it is essential to have a tool such as News Rover to identify messages of interest to you.

Binary file attachments



Introduction to News Rover

News Rover is the ultimate tool for browsing Usenet newsgroups.    It is your personal robot that will look 
for messages containing items of interest to you.    When it finds these messages it will store them for you 
and automatically decode binary file attachments.    News Rover works for you while you are doing other 
things.

You define "Interest Groups'' that specify what newsgroups you want News Rover to search and what text
or files you want it to collect.    When you run News Rover, it connects to your Usenet news server and 
begins scanning all new messages.    Whenever it finds one that contains text or files that are wanted by 
an interest group, it decodes the files and stores the message and files in an area associated with the 
interest group.    This searching, downloading, decoding, and storing is done automatically without 
requiring your time or attention.    You can leave News Rover running while you are sleeping or at work.    
The messages and files that News Rover collects are stored on your personal computer so that they are 
available for instant access when you are ready to review them.

Summary of features
Obtaining the full, licensed version of News Rover



Server configuration page

The first item on the Server configuration page is the address of your news server.    Usually this address 
has the form "news.myprovider.com''.    If you don't know the address of your news server, you should 
contact your Internet service provider and ask them.    You should ask them for the address (or "domain 
name'') of your Usenet news server.    Sometimes this is referred to as an "NNTP server.''    Some sites 
may provide an IP address in "dotted notation'' such as "127.23.40.100'' rather than a domain name.

The other items on the Server configuration page are optional and are usually not required.    Some news 
servers require an account name and password to be specified by programs connecting to them.    Most 
news servers do not require this and do their only authorization when you specify your account and 
password at the time that you dial-in to them and log on.    Your Internet service provider should be able to
tell you whether programs like News Rover need to specify an account name and password when they 
connect to the news server.    If an account name and password are required, click the box titled "Logon 
authorization required for this server'' and specify the account name and password.

If you have been using another program such as Microsoft Internet Explorer to access your newsgroups, 
you should specify the same news server address and logon name and password for News Rover that 
you specified in the newsgroup configuration of your news browser.



General configuration page

Free disk space limit
Run delays
Newsgroup name display
JPEG viewer selection



Connection configuration page

This configuration page is used to specify information about how News Rover should connect to your 
Internet service provider.    If you establish the connection yourself by invoking the Windows dialer, you do
not need to set any fields on this page.    However, by setting some of the items you can take advantage 
of some News Rover features such as automatically reconnecting if the connection is dropped.

Type of Internet connection
Dialing information
Connection control
Disconnection control



Schedule configuration page

The Schedule configuration page controls whether News Rover runs only on your command (i.e., when 
you click the Run button), or whether it runs automatically on a scheduled basis.

If you select the option labeled "Use this schedule'', then News Rover runs automatically on a scheduled 
basis and the matrix of scheduling times is enabled.    You should check those hours when you want News
Rover to run.

When scheduled mode is selected, News Rover sleeps until a scheduled run time arrives.    It then begins 
running, dials your Internet service provider if it is in automatic dial-up mode, connects to the news server,
and begins scanning your selected newsgroups for messages.    It continues running until either their are 
no more newsgroups that need to be scanned or a time arrives when it is not scheduled to run.    News 
Rover only stops running between messages.    So if it is downloading a large message when an hour 
occurs that it is not scheduled to run, it completes the current message download before suspending its 
execution.    Information about the current newsgroup and message is stored so that it can restart at the 
same position when the next scheduled time arrives.

You can override the run schedule and force News Rover to run by clicking the Run button on the main 
menu.    You can also click Suspend or Quit to stop News Rover.

Unless you have a continuous Internet connection, you should go to the Connection configuration page 
and specify the dial-up connection that News Rover should use to connect to your Internet provider.



Duplicates configuration page

If you enable duplicate file exclusion, then News Rover maintains a database with the names and sizes of
all files that it has downloaded for you.    Each time it downloads a file it compares the name and size of 
the file against the entries in the database.    If the name matches and the size is approximately the same,
it considers the file to be a duplicate and it discards it.    This prevents you from seeing the same "spam'' 
file uploads over and over.    If you disable duplicate file exclusion, then no database is maintained and no 
files are excluded because they have been seen before.

The next field is labeled "Expire duplicate entries after this many days''. When an entry is added to the 
duplicate file database, the date is stored with it.    When an entry in the duplicate file database is as old 
as the number of days specified here, it is expired and removed from the database.    If a duplicate is 
found after this, it will be saved (and a new entry made to the database at that time).    Usually, duplicate 
file entries show up on newsgroups around the same time.    Expiring entries is a way to keep the 
duplicate database from growing without bound. If you set the expiration period to 0 (zero), then the 
duplicate file entries are never expired.

Below these options is a list of the files that are currently stored in the duplicate file database.    If you wish
to remove a particular entry, highlight it and click the button labeled "Delete''.    You can click "Delete all'' to
remove all entries from the duplicate file database.



Split-message files configuration page

Some computer systems are unable to handle very large newsgroup messages. Because of this, when 
large binary files are attached to messages they are usually split into multiple parts and attached to 
several messages.    The usual convention is to indicate this in the subject of the message: for example, a
subject such as "bigprog.zip (1/8)'' indicates that this message contains part 1 of bigprog.zip which has 
been split into 8 messages. Sometimes a part 0 (zero) is also distributed which contains a description of 
the file.

News Rover contains a very sophisticated system for reconstructing files that have been split across 
multiple messages.    If this feature is enabled, News Rover examines the subject of each message to 
determine if it is a segment of a multi-part file.    If it is, News Rover stores the message, and it records in 
a database which parts have been collected. When all of the parts of the file have been collected, News 
Rover merges the messages and decodes the complete file.    Because News Rover stores information 
about the parts in a database, it can collect parts from multiple runs and possible even over a period of 
several days or weeks. Also, News Rover can combine parts from multiple newsgroups.    This greatly 
increases the chance of finding all of the parts of a file that has been split into many parts.

In addition to allowing you to enable or disable the multi-part file reconstruction, the configuration page 
also allows you to specify how many days News Rover should store the parts of an incomplete file before 
giving up and deleting those parts that were collected.    Usually, if all of the parts have not been found 
within 30 days, the missing parts will probably not show up.    The date recorded for files is reset each 
time a missing part is found, so the expiration only takes place if no new parts are found within the 
specified number of days.    If you set the expiration period to 0 (zero), then the parts are never expired.

Below these controls is a list of the files for which News Rover is looking for missing parts.    The list 
shows the name of each file, the total number of parts that comprise the file, the number of parts that 
have been collected, and the date when the last part was found.    If you wish to delete an entry, highlight 
it by clicking on it, then click the "Delete'' button.    This deletes all the pieces News Rover has collected so
far.    You can delete all parts of all pending files by clicking the "Delete all'' button.



Getting the list of newsgroups

Once you have configured News Rover, the next step is to get the list of newsgroups that are available on
your news server.    To do this, connect to your Internet provider and then click "Get-newsgroups'' on the 
main News Rover menu.    News Rover will display a status box while it is accruing the list of newsgroups.



Creating an Interest Group

When you click the "New interest group'' button, a "wizard'' starts which will guide you through creating a 
new interest group.    Hopefully, the wizard will be self explanatory.    However, if there are particular items 
which are not clear, please refer to the description of these items in the following section that describes 
the options available when modifying an interest group.



Modifying an interest group

To modify an interest group, first get to the screen that displays the list of interest groups and control 
buttons (click "Interest'' on the main screen).    Next, click on the name of an interest group and then click 
the "Modify interest'' button (you can also double-click the interest group name).

You will be presented with a property sheet with a number of property pages that you can select by 
clicking on a tab.    The following sections describe each of these property pages.

General options
Newsgroups to search
Message selection
Attached file control
Scan date control



On-demand execution

On-demand is the most commonly used mode of execution.    When you are ready for News Rover to go 
to work, just click the Run button.    News Rover will connect to your news server and begin scanning 
newsgroups for messages. If you click the Suspend button, News Rover will suspend its scanning after it 
finishes downloading the current message.    You can click Run again to resume its execution.    Click the 
Quit button when you want News Rover to stop and exit.

Because of News Rover's efficient design, you can read messages and view downloaded pictures while 
News Rover is running.



Scheduled execution

Scheduled execution is another way to run News Rover.    In this mode of operation News Rover sleeps 
until a time when it is scheduled to run.    It then wakes up, connects to your news server, and begins to 
scan messages. It continues to run until a time when it is scheduled to sleep.

To use scheduled execution mode you must first configure News Rover so that it knows what times it 
should run.    Do this by clicking the Configure button on the main screen and then clicking the Schedule 
tab on the property sheet.    Check those hours when News Rover should run.

If you want News Rover to dial your Internet service provider automatically, you should also go into the 
Connection configuration page and set up information about which dialing entry it should use to establish 
the connection.



Reading messages

Click the "Messages'' item on the main menu when you want to read messages that News Rover has 
collected.    This brings up the list which displays the names of each interest group and shows how many 
new messages and files have been collected during the current run.    To see the list of messages for an 
interest group, just click on the name of the interest group.    You will then be presented with a screen 
showing all messages that have been collected for the interest group.    To read a message, click on the 
subject of the message.    A red check mark appears to the left of each message that has been read. You 
can change the size of this window by clicking on a border and dragging it in or out.

You can delete all messages that have been read by clicking the "Delete-read'' item on the message list 
menu.    You can delete all messages by clicking the "Delete-all'' item.    When a message is deleted, all 
files attached to it are also deleted.    However, if you have saved files in a permanent storage area, those 
files are not deleted.

When you click on a message subject, the text of the message appears. If the message had an attached 
file then the text which contained the attached file is replaced with a small message indicating the name 
of the attached file. The attached files are available via the menu option "Attachments''.

From this window you can do the following things with the message:

1. File --- This brings up options, some of which are also available from the menu.

1. Save msg --- This will allow you to write the message to an external file. This will not 
save an attached file, if there is one, only the text of the message. This is the same as 
the "Save-message'' option on the menu.

2. Print msg --- This will print the text of the message. This willnot print any attached files, 
only the text of the message.

3. Save file --- If there are attached files, this will save them in the directory you specified 
for saving attached files when you created the interest group. If you did not specify a 
directory for saving files, a browse screen will appear. This is the same operation as the
"Save-file'' option on the menu.

4. Save file as --- If there are attached files, it will pull up a browse screen and let you 
specify a file name and directory where the attached files are to be stored.

2. Next --- This will advance to the next message saved for this interest group.

3. Previous --- This will return to the previous message.



4. Save-message ---    This will allow you to write the message to an external file. This will not save 
an attached file, if there is one, only the text of the message. This is the same as the "Save file '' 
option displayed in the File option.

5. Save file --- If there are attached files this will save them in the directory you specified for saving 
attached files. If you did not specify a directory for saving files a browse screen will appear. This 
is the same operation as the "Save-file'' option on the File option. If there are no attached files 
associated with the message this option will be grayed out.

6. Attachment --- If there are attached files associated with the message, this will allow you to 
display the names of the files. If you click on a name, News Rover will attempt to start the 
appropriate program to process the file based on the type of the file (JPG, GIF, MPG, WAV, etc.).



The Picture Gallery

One of the most popular uses for News Rover is downloading, decoding, and viewing picture files 
attached to Usenet messages. To make this process as efficient as possible, News Rover includes a 
"Picture Gallery'' feature.

As pictures are received for an interest group, they are stored in a holding directory associated with the 
interest group. When you select the picture gallery for the interest group, you are shown an array of 
thumbnail pictures of the pending pictures for the interest group.    You can control the size of the 
thumbnail pictures, but usually 9 to 12 are visible at a time. You can adjust the size of the gallery display 
to match your screen size. You can use the scroll bar, the Page up/down keys, and the arrow keys to 
move through the set of pictures in the gallery. You can change the size of the picture gallery by clicking 
on a border of the window and dragging it in or out.

Video modes





Binary file attachments

In addition to distributing messages, Usenet newsgroups also distribute binary files that are attached to 
messages.    There are many newsgroups specifically designated for binary file distribution (alt.binaries..., 
etc.) In these newsgroups you will find picture files (JPG, GIF, etc.), sound files (WAV), multi-media files 
(MPG, MOV, AVI), and compressed program and data files (ZIP).

In order to attach a binary file to a message, it must be converted into a pseudo-text format that is suitable
for distribution through the newsgroup channels.    There are two encodeding methods for doing this: "UU-
encoding'' and "MIME base64 encoding''.    UU-encoding is the traditional and most popular method, but it 
is gradually being supplanted by the newer MIME base64 encoding.    In order to use an attached binary 
file, you must first download the message with the attachment, and then decode the encoded binary file 
into the original binary form.

Some computer systems are unable to handle very large newsgroup messages. Because of this, when 
large binary files are attached to messages they are usually split into multiple parts and attached to 
several messages.    The usual convention is to indicate this in the subject of the message: for example, a
subject such as "bigprog.zip (1/8)'' indicates that this message contains part 1 of bigprog.zip which has 
been split into 8 messages. Sometimes a part 0 (zero) is also distributed which contains a description of 
the file.



Summary of features

Here are some of the key features of News Rover:

News Rover saves you time.    Instead of spending hours examining messages in newsgroups, 
you can leave News Rover running while you are sleeping or at work.    When you are ready, you
can quickly review the messages and files that it has collected.

Automatic file decoding.    News Rover automatically decodes both UU-encoded and MIME 
base64 file attachments.    The decoded files are stored in their natural binary form ready to be 
viewed, played, or executed.

Picture gallery.    News Rover includes a built-in "Picture Gallery'' to display decoded JPG picture
files.    The gallery displays an array of thumbnail images.    You can quickly browse pictures in 
the gallery, save the pictures that interest you and delete the others.

Message searching and selection.    When you define an "Interest Group'' you can specify words 
or phrases that you want News Rover to search for. This search text can occur in either the 
header or body of messages.    News Rover then scans the messages in the newsgroups and 
saves only those messages that match what you have specified.    You can search for multiple 
words and phrases joined with "and'', "or'', "near'', and "not'' operators. You can also use 
parentheses to construct complex search expressions.

File selection. You can define interest groups specifically to pick up messages with binary file 
attachments. News Rover will discard any messages that do not have attached files for these 
interest groups.    This eliminates a great deal of clutter and advertisements that are posted on 
binary newsgroups. You can tell News Rover to collect all types of file attachments, or you can 
set it to only store certain types of files (JPG, GIF, MPG, etc.).

Split-message file reconstruction.    Large binary file attachments are usually divided into parts 
and attached to multiple messages. News Rover collects the messages that comprise a split-
message file.    When all of the parts have been found, News Rover combines them and decodes
the complete file.    News Rover saves information about file parts in a database so that it can 
continue to collect missing parts on subsequent runs.    It can also collect and combine parts 
found on multiple newsgroups.    This greatly increases the chances of finding all of the parts of a
many-part file.



Duplicate file elimination.    You will discover that some files are reposted on newsgroups 
regularly.    Some of these files are commercial advertisement messages (i.e., "spam'' 
messages), others are just files that overly enthusiastic people want to share over and over.    In 
either case, it is a nuisance to receive the same file repeatedly.    News Rover maintains a 
database with the names and sizes of all files that it has collected for you. If a file is found that 
has the same name and size as one that is already in the database, News Rover does not 
collect it again. You can remove individual entries from the database if you want to get the file 
again, or you can disable this feature altogether if you wish.

Scheduled runs.    If you wish, you can set up News Rover to run automatically at scheduled 
times.    In this mode, News Rover sleeps until a scheduled run time arrives.    It then wakes up, 
connects to your news server (dialing the phone if necessary), and runs until all newsgroups 
have been processed or another sleep time arrives.    This can maximize the use of your Internet 
connection and phone line by allowing News Rover to use your connection and phone line at 
times when it would normally be idle.    News Rover can be set to release the line at times when 
you wish to have it available for incoming calls.



Obtaining the full, licensed version of News Rover

There are two versions of News Rover: the shareware demonstration version, and the fully licensed 
version.    The shareware demonstration version of News Rover is available for you to try out News Rover 
for free.    The demonstration version provides all of the features of News Rover but is limited so that it will
only collect 20 messages or files each time it is run.    You can stop and restart it to collect more 
messages and files.    The demonstration version also displays a shareware reminder screen each time it 
is started.    You are welcome to give copies of the shareware demonstration version of News Rover to 
your friends or post it on computer "bulletin boards'' or Internet file download archives.

Once you try the demonstration version, we are convinced that you will want to purchase the licensed 
version of News Rover which has no restrictions on the number of messages and files that it can collect 
during each run.    The purchase price of the fully licensed version is only$29.95.

Registration key



Free disk space limit

The first item on the General configuration page is "Free space to reserve on disk''.    News Rover is a 
very efficient program; if you leave it running for a number of hours it can download hundreds of 
messages and files.    If the remaining free space on your disk declines to the point that it is less than the 
amount you specify in this field, News Rover will suspend its execution.    This prevents News Rover from 
completely filling up your disk with downloaded files.



Run delays

The second field is "Minutes to delay between runs''.    Each time you run News Rover, it examines the list
of newsgroups that need to be scanned, and it processes the newsgroup that has been scanned the 
longest time ago. If a newsgroup has been scanned more recently than the number of minutes specified 
by the "Minutes to delay between runs'' value, then News Rover does not rescan that newsgroup until the 
specified time has elapsed.    This prevents News Rover from running continuously.

If your Internet service provider disconnects you if you are idle for a certain number of minutes, you can 
avoid this disconnection by setting this value to a time less than the idle-disconnection time so that News 
Rover will generate some activity frequently to maintain the connection.



Newsgroup name display

The next field is titled "Display newsgroup name in status box''. Normally, while News Rover is running, 
the name of the current newsgroup is displayed in the status box on the main screen.    If you are 
scanning certain newsgroups whose names you would prefer not to have displayed, you may uncheck 
this option.



JPEG viewer selection

This option allows you to select whether the built-in JPG picture viewer should be used, or whether News 
Rover should invoke an external program to view JPG pictures.    The built-in News Rover JPG viewer 
usually does an excellent job and is faster than invoking an external viewer program. However, if you 
prefer to use an external program such as LViewPro, Paintshop Pro, or some other program, just select 
the "Use external JPEG viewer item''. In order to use an external JPG viewer, the viewer program must 
have declared itself as the program to service ".JPG'' type files. The built-in viewer is always used to view 
the picture galleries.

If you select an attached file that has an extension other than ".JPG'', News Rover always attempts to 
start the appropriate program to service it. For example, if you select a GIF file, you must have installed 
an external viewer program.    Similarly, News Rover will attempt to locate and start external program to 
service MPG, WAV, and AVI files.



Type of Internet connection

You should select one of these three choices:

"I will manually initiate dialing to connect to the Internet''.    Select this item if you will connect to 
the Internet yourself before running News Rover.    When you select this item you must connect 
to your Internet provider before running News Rover.    You should use the same technique for 
connecting to the Internet that you use for other programs such as Netscape or Microsoft 
Internet Explorer.

"News Rover should automatically dial to connect to Internet''.    Select this option if you want 
News Rover to initiate a dial-up connection to your Internet service provider when it runs.    This 
option is especially useful when you use News Rover in scheduled mode so that it can wake up 
at scheduled times, dial-up your Internet service provider, and scan for messages on an 
unattended basis.    If you select this option, you must also fill in the "Dialing information'' fields.

"I use a LAN (hardwired) Internet connection''.    If you are connected to the Internet through a 
permanent (hardwired) connection you should select this option.



Dialing information

If you click the down-arrow symbol at the right end of the field labeled "Use this dial-up networking 
connection'', a list will drop down showing all of the dial-up connections that Windows knows about.    
Select the dial-up entry that you want News Rover to use when it dials your Internet service provider.    Fill
in the name and password that News Rover should use when logging on to your provider.



Connection control

In the first field, specify the number of attempts News Rover should make to connect to your Internet 
service provider if a dial-up connection fails.

If you check the "Redial if disconnected'' box, and if you have specified a dial-up connection, News Rover 
will attempt to reconnect to your Internet service provider if the connection is broken while News Rover is 
running. Checking this box also causes News Rover to attempt a reconnection even if you have selected 
the option "I will manually initiate dialing to connect to the Internet''.



Disconnection control

If you check the "Hold continuous connection'' option, then News Rover will never hang up the phone to 
your Internet service provider even if it initiated the connection.    If you do not check this box, then the 
field titled "Disconnect if idle for this many minutes'' is enabled.    If News Rover is in automatic dial-up 
mode, and it needs to go to sleep for this many minutes, it will hang up the connection.    In automatic 
mode, it will redial your provider when it needs to run again.



General options

The first field is the name of the interest group.    This can be anything meaningful to you.

The next choice is whether you want the interest group to store messages, files, or both messages and 
files.    If you are setting up an interest group to collect binary picture files, it is best to specify that you only
want messages with attached files.    This is cause News Rover to discard messages that don't have 
attachments; these are usually "spam'' advertisements.

News Rover will construct the proposed name of the home directory for the new interest group.    If you 
wish to use the directory that News Rover suggests, just proceed on to the next field.    Otherwise, edit the
field to specify the home directory you want to use.    Subdirectories will be created below this home 
directory to hold files and gallery images for the interest group.



Newsgroups to search

This property page displays the newsgroups which will be searched for messages and files for this 
interest group. If you wish to remove a newsgroup from the list, click its name and then click the "Remove
newsgroup'' button.    You can click "Remove all'' to remove all newsgroup names.

To add new newsgroups to the list for the interest group, click the "Add newsgroup'' button. News Rover 
then displays the list of all newsgroups that are available on your news server.    To select a newsgroup, 
click on its name and then click the "Select'' button.    You can also double-click on a name to select it.    If 
you hold down the Control key while clicking on a name, that name is selected and any other names 
remain selected.    You can use this method to highlight several names before clicking the "Select'' button. 
Another way to select a set of names is to click on the first name and then hold down the Shift key while 
clicking on the last name. This selects all newsgroups between the first one you clicked and the last one 
you clicked.

You can remove newsgroups from the interest group by clicking on a name and then clicking the 
"Deselect'' button.

A red triangle appears to the left of the names of newsgroups which are currently selected for the interest 
group.    You must select at least one newsgroup and you can select as many as you wish.    You can also 
include the same newsgroup in several interest groups.

Initially, the names of all available newsgroups are displayed in the list. However, it is frequently useful to 
display only the set of names that contain some string such as "forsale'' or "pictures''.    To do this, simply 
type a string in the field labeled "Display newsgroups which contain''.    Do not press Enter after typing this
string; just wait a second or two.    The list will then change to display only those newsgroups whose 
names contain the string you specified.    You can edit the selection string at any time to change the list of 
newsgroups that are displayed.



Message selection

The Include and Exclude expressions control which messages News Rover will collect for you.    If you 
want to collect all messages from a set of newsgroups, just leave the include and exclude expressions 
blank.

Frequently, when interest groups are set up to collect binary picture files the include and exclude 
expressions are left blank, and the option is selected to cause News Rover to collect only messages with 
attached files.    However, you are welcome to use the include and exclude expressions while collecting 
files.

If you specify an include expression, only those messages that match the expression will be collected.    
The expression can be as simple as a single word, or it can be a complex expression with AND and OR 
operators and parentheses.

If you specify a word using all lower-case letters, the word is compared with message text in a case-
insensitive manner.    For example, the word "apple'' would match "apple'', "Apple'', or "APPLE''.    
However, if the word you specify contains any upper-case characters, then the comparison is case 
sensitive.    So, if you specify "Apple'' it would not match "apple'' or "APPLE''.

You can also specify a sequence of words separated by spaces or punctuation characters (i.e., a phrase).
A match will occur only if a message contains the same sequence of words in the same order.    The 
punctuation characters separating the words are not used in the comparison.    For example, the search 
expression "John Wayne'' would match "John,Wayne'' but it would not match "Wayne John''.    Case 
sensitivity is determined on a word-by-word basis depending on whether words contain upper-case 
letters.

A word you specify using all lower-case letters will match a word in a message if the word in the message 
begins with the word you specified.    For example, if you specify "apple'', it will match "apple'' and 
"apples''.    If you want to require an exact match, include the word (or phrase) in quote marks. If the word 
you specify has any upper-case letters, it is considered to be a proper noun and exact matches are 
performed.    You can force a search word with upper-case letters to match words beginning with that word
by specifying '*' as the last character of the search word.    For example, "Apple*'' will match "Apple'' or 
"Apples''.

In addition to words and phrases, you can also use four operators: AND, OR, NEAR, and NOT.    The 
names of the operators are not case sensitive.

AND operator
NEAR operator
OR operator
NOT operator
Exclude expression



Attached file control

Each interest group has several controls related to attached files.

Attached file directory
Attached file size limits
JPG picture gallery control
File type selection



Scan date control

Each time you run News Rover, it scans the selected newsgroups and examines messages that have 
been posted since the last scan.    If you interrupt News Rover while it is scanning a newsgroup, when it 
restarts it starts over from the previous starting date, but it skips over messages that it has already 
examined.

When you create a new interest group, News Rover initializes the last-scan date to two weeks prior to the 
current date.    This means that the first scan will examine all messages posted during the last two weeks.

If you wish, you can modify the last-scan date to cause News Rover to examine messages posted within 
a certain number of days.    To do this, select the Dates tab on the set of interest group modify pages, then
specify the number of days that you want to go back when News Rover next runs.    Setting a date here 
causes all newsgroups associated with the interest group to be scanned for messages since that date.



Video modes

If your video adapter has the capability of supporting "Truecolor'' (24 bit) display mode, you should select 
it while viewing the picture gallery. 256-color mode is also supported, but the colors will not be very good 
while viewing the collection of pictures in the gallery because News Rover can not set the color palette to 
optimize the colors for a particular picture.

If you wish to see the full size version of a picture in the gallery, simply place the cursor over the 
thumbnail image and click the left mouse button. To remove a picture, place the cursor over the thumbnail
image and press the Delete key.

As you find pictures in the gallery that you wish to add to your permanent collection, just position the 
cursor over the thumbnail image and click the right mouse button. A popup menu will appear with the 
following options:

1. View fullsize --- Invoke the jpeg viewer and displays the image full size. From the 
Configuration/General menu you can configure News Rover to use either the built-in JPG viewer 
or an external JPG viewer such as LViewPro or PaintShop.

2. Save picture --- Saves the picture in the directory that you specified for images associated with 
the interest group. After saving, the picture is not deleted from the gallery.

3. Save as --- Saves the picture but will allow you to specify the name of the file and directory. After 
saving, the picture is not deleted from the gallery.

4. Save and Delete --- This will save the picture in the directory that you specified for the interest 
group and then delete it from the gallery. When you delete the picture the corresponding 
message is also deleted.

5. Delete --- Deletes the picture from the gallery. When you delete the picture the corresponding 
message is also deleted.

You can view and manage pictures in the gallery while News Rover is running and collecting more 
messages and pictures. With the picture gallery you can review hundreds of pictures in a few minutes and
quickly select the ones that are worth saving.





Registration key

When you purchase a license to use News Rover, you will receive an installation key that converts your 
demonstration version into the full, licensed version.    In other words, the demonstration version of the 
program is the same as the licensed version but a key must be entered to unlock the full features.

There are several ways to license News Rover and obtain your installation key:

Web page registration.    Probably the simplest way to connect to our web page, 
www.NewsRover.com, fill out the on-line registration form and provide credit card information.    
After the credit card information is verified, the installation key will be e-mailed to the address 
you specify on the form.

E-mail registration.    You can also purchase News Rover by sending an e-mail message to 
"NewsRover@sandh.com''.    Provide your credit card information including the expiration date.    
The installation key will be sent to you via e-mail.

Telephone registration.    If you prefer to talk to someone on the phone, you can call in your order
to 615-327-3670.

FAX registration.    You can also FAX in your registration to 615-321-5929.

Mail registration.    Finally, if you don't like modern conveniences, you are welcome to mail your 
order to: S&H Computer Systems, Inc., 1027 17th Avenue South, Nashville, TN 37212, USA

Once you purchase a registration for News Rover, you will receive two items of information (1) the 
registered name, and (2) the installation key.    The registered name is your name from your credit card, or
an alternative name if you requested it.    Each time you run the unlicensed version of News Rover, you 
are presented with an initial welcome screen that reminds you that you are using an unlicensed version.    
One of the tabs on this screen is "Register''.    To apply the registration key, click on the "Register'' tab and 
enter the registration name and key into the appropriate fields.    Be sure to save the registration name 
and key in case you need to reinstall News Rover.

Note: The licensed version of News Rover is not shareware and maynot be given to friends or distributed 
without the written consent of S&H Computer Systems, Inc.    News Rover is protected by the copyright 
laws of the United States of America and cooperating countries.    "News Rover'' is a trademark of S&H 
Computer Systems, Inc.



AND operator

The AND operator will match if a message contains both of the words (or phrases).    The words do not 
have to be adjacent and may be in either order.    For example, the search expression "John and Wayne'' 
would match any message that contained the two words "John'' and "Wayne'' regardless of order or 
position.



NEAR operator

The NEAR operator is similar to the AND operator.    However, the NEAR operator will only match words 
that are separated by no more than 8 other words.    The order does not matter.    For example, the 
expression "1965 near Mustang'' would match "1965 blue Ford Mustang''.



OR operator

The OR operator will match a message if either word (or phrase) occurs in the message.    For example, if
you are looking for message about either John Wayne or Henry Fonda, you could use the search 
expression "John Wayne or Henry Fonda''.



NOT operator

The NOT operator matches if the message does not contain the specified word or phrase.    For example, 
if you are interested in messages about music but you don't want to hear about Michael Jackson, you 
could use the expression "music and not Michael Jackson''.

If you wish, you can construct complex search expressions with many words, operators, and parentheses.
For example, the following expression could be used to search for messages about Nikon or Minolta 
cameras:

(Nikon near camera) or (Minolta near camera)



Exclude expression

The exclude expression can include the same type of expressions as the include expression.    If the 
exclude expression matches a message, the message is excluded even if the include expression also 
matches it.

You can use the exclude expression to exclude messages containing certain words or phrases.    You can 
also use it to exclude messages posted by a certain individual by specifying their name or Internet 
address in the exclude expression.



Attached file directory

The first control is the directory where approved attached files are stored.

When an attached file is extracted from a message and decoded, it is initially stored in a subdirectory 
named "files'' below the home directory for the interest group.    Files are stored in this holding directory 
until you review them by examining the messages for an interest group or by browsing the picture gallery. 
If you delete a message, or delete an entry from the picture gallery, the attached file(s) are deleted from 
the holding directory.    However, if you specify that you want to save the files attached to a message, the 
files are copied from the holding directory to the permanent storage directory that you specify for the 
interest group.



Attached file size limits

The next two controls allow you to specify the range of sizes of attached files that are acceptable to you.   
If the size of an attached file is less than the minimum size you specify, or if it is greater than the 
maximum, then the file is discarded and not stored.    If you leave a size limit blank (or if you specify 0) 
then the limit is ignored.

The main uses of file size limits are to exclude picture files that are too small to be interesting, and to 
exclude very large files.



JPG picture gallery control

The next controls for attached files relate to the JPG picture gallery. If you enable the picture gallery for an
interest group, then when an attached file is decoded that has the extension ".JPG'', a thumbnail image of
the picture is generated and stored so that it can be displayed in the gallery.    If you disable the gallery, no
thumbnail images are generated.

The second gallery control specifies how large the thumbnail images should be.



File type selection

The last control for attached files determines whether all types of attached files are to be stored, or if you 
only want certain types of files.    If you choose the "Select only these file types'' option, then you should fill
in the field with the types of the files that you want to store.    For example, if you set up an interest group 
to collect multi-media files, you might want to specify that you only want to store MPG and AVI files.    
Specify the file types with a single space between them.








